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Conventions Used in this Manual 

Bold The names of screen objects, such as menu choices, window names, 

field names, and items in lists. 

Italics Italics are used for emphasis or to highlight an important word or concept. 

Monospaced Pathnames, filenames, and code are shown in monospaced font. 

Monospaced 

Bold Values you must type in are shown in monospaced, bold font. 

Monospaced 

Italics Variables, such as a server name, are shown in monospaced, italic font. 

These are usually enclosed in angled brackets <servername> as well. 

[Inside Brackets] Keyboard keys, such as [ENTER] or [Page Up] are shown inside brackets. 
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Introduction 

Thank you for using Gobe Productive from Gobe Software. If this is your first 

time using Gobe Productive, this guide introduces the basic components of the 
Productive suite. 

Gobe Productive is a powerful, fully integrated suite of office and graphics tools 

designed exclusively for BeOS. At the core of Gobe Productive is a flexible and 

easy to use document-centric design. Modular plug-in components, called parts, 

make adding new features and capabilities simple and flexible. 

Using different frames, you can place graphics, text, images and spreadsheets all 

within a single document. Each frame behaves like a graphic object. For 

example, a spreadsheet frame can be rotated 90 degrees and layered on top of a 
rectangle graphic to create a unique design for your document. Furthermore, 

this spreadsheet frame is also a fully functioning, floating environment capable of 
being directly edited. 

Gobe Productive Parts 
Five types of documents comprise the “top level” of the Gobe Productive Suite: 

Graphics, Word Processing, Spreadsheet, Image Processing, and Presentation. 

This section introduces these documents. For detailed instructions on how to 

use the different document types, and for specific questions, see Section IV “For 

More Help” on page 33. 

New Document | — 

wf, Graphics 

Fl Spreadsheet 

Gobe 
Productive - Image Tanaomane | 

Open... | Cancel | OK i 

Figure I — The New Document dialog box with the five types of documents you can 

create in Gobe Productive. 
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Graphics 
The graphics environment is tuned for the design and layout of graphic objects. 
The environment includes tools for drawing lines, curves, shapes, and other 
graphic items. 

(E003 JG] Not paginated || 

Figure 2 —Graphics document example. 

Graphic documents are ideal for laying out many different types of frames. For 
example, if you wish to create a graphically rich newsletter which contains text, 

pictures, and a spreadsheet table, a graphics document is the best environment 
to use. 
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Word Processing 
A word processing document is a text-based environment. Word processing 

documents are ideal for letters, reports, books, proposals and anything where a 

lot of text is used. 

Ernie G. Pan 
3267 Main Street 

Sloan, IA 51065 

(505) 428-6435 

Objective Position of Benevolent Dictator of Freedonia 

Qualifications | - successfully implemented systems that contributed to the public 
good and welfare 

- achieved the highest possible popularity rating as senator 
+ strong international relation skills 
> fluently speak five languages and all Freedonian dialects 

Experience Freedonia Legislature 1982- 1997 
Senator care 

etl 
Was elected by the highest popular majority in Freedonian history. Sponsored 
scores of bills that were passed almost unanimously, some of which include: no 
taxes for anyone, free healthcare, childcare on demand, anda guaranteed 
retirement account for every citizen. Retired to Sloan while awaiting the popular 

demand to return as benevolent clictator. 

Pie 

Acme Industries, Zanadu, Freedonia __1972- 1982 
. Clweerase 1 SE aaa : = BREE 

Figure 3 — Example of a word processing document. 

Although the word processing document is specially designed for writing text, 

you can easily integrate graphics, charts, and spreadsheets into the text flow. 
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Spreadsheet 
A spreadsheet document is a cell-based environment. It is the best place for 

number crunching and data organization. Spreadsheet documents can also create 

colorful charts and graphs. 

Invoice # 

‘Bill To: [Name of Company 

Description 

1602 | Hyper Cadium Cell 

1004 | Deluxe Widget 

4933 | Micro Lineator 

Sales Tax Rate: SubTotal: 
: Shipping / kg: Shipping: 

Total Weight ; Salee Tax: 

Figure 4 — Spreadsheet example. 

The Gobe Productive spreadsheet recognizes many different kinds of data: 

numbers, currency, scientific notation, text, dates, times, true/false, and formu- 

las. Over 100 built-in mathematical, scientific, and financial functions make 

calculations easy. 

Spreadsheets are also great for organizing information. For example, you can 

use a spreadsheet to alphabetize a list of names. In this way, a Gobe Productive 

spreadsheet functions as a simple database. Use it to store information about 

inventories, contacts, and investments. 
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Image Processing 

Image Processing is a digital image environment ideal for touching up and 

editing image files and digital photographs. 

ai] 
Document — Frame Window — 

eeNag 

Figure 5 — Example of an Image Processing document. 

For example, if you have a digital image, you can copy it to your system and edit 

the picture for use in other documents. Gobe Productive supports many stan- 

dard graphics formats such as TIF, TGA, and JPG. 
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Presentation 

A Presentation document is a graphics-based environment with the ability to 

create and display slide shows. 

i Edit Document Frame wile ae a iC 

Bj- aac | 
| 

134 NW Cedar Avenue 

Kittens 
Puppies 
Hamsters 
Supplies 
Toys 
Grooming 

Samantha's Pet Shop 

Figure 6 — Example of a Presentation. 

The Presentation environment has a sophisticated layering system for construct- 

ing slide shows. For example, you can create a presentation that reuses the same 

elements many times without having to copy and paste those items from slide to 

slide. Moreover, you can create multiple backgrounds or “master slides.” 

Environments 
All documents and frames in Gobe Productive have an environment. An environ- 

ment is a set of tools and features available for a frame or document type. Gobe 

Productive dynamically changes the environment to reflect the currently active 

document or frame. For example, if you are working on a word processing 

document, the word processing environment is active. If you then activate a 

spreadsheet frame within that word processing document, the spreadsheet 

environment becomes active. The Environment Icon indicates which environ- 

ment is currently active. 

Throughout this manual and the on-line help, the term environment is used to 
refer both to a document and a single frame. 
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Installing Gobe Productive 

This section describes the requirements and instructions for installing Gobe 
Productive on your system. 

Pre-Installation Considerations 
Before you install Gobe Productive please consider these requirements. 

H Operating System: BeOS Release 4.5 or better. 

M@ Memory: Minimum of 32 MB required, 64 MB recommended. 

M@ Hard Drive Space: 20 MB free. 

Installation Instructions 
1. Insert the Gobe Productive CD into your CD-ROM drive. 

2. Double-click the Gobe Productive CD icon to open the CD. 

Note: Ifthe Gobe Productive CD icon does not appear automatically, click 
and hold your mouse on the desktop. Select Mount from the desktop 
context menu, and then select Gobe Productive from the displayed sub- 
menu. 

3. Once inside the CD folder, double-click Install Gobe Productive. 

4. Follow the on-screen installation instructions. 

5. The Gobe Productive setup is complete. 

Note: When you update Gobe Productive, install the new version of the 
software in the same directory as the old version. If asked whether to 

replace a file, select Replace All, and click OK. The new files over- 

write the old files, and the new updated version is installed. 

Uninstalling Gobe Productive 
To uninstall Gobe Productive, move the folder or directory where Gobe Produc- 
tive is installed to the trash and then empty the trash. 

Section Il - Installing Gobe Productive 11 
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OOH User Interface Overview 

This section contains the basic concepts on how to use the Gobe Productive 
suite effectively. 

Running Gobe Productive 
Gobe Productive is a fully integrated suite of tools. Only one application is 

required to access all the tools and power of Gobe Productive. 

There are two ways to start Gobe Productive: 

1. Double-click the Gobe Productive desktop icon linked to the Gobe 

Productive application 

2. Click the main Be menu. From the Applications folder, select Gobe 
Productive. 

Once opened, the New Document dialog box is displayed. If you wish to 

start a new file, select the type of document you wish to create and click 

OK. If you wish to open an existing file, click Open. 

JES Spreadsheet 

a Image Processing 

=, Presentation 

Figure 7 — The New Document dialog box with the five types of documents you can 

create in Gobe Productive. 

If you are opening an existing file, a standard BeOS Open File dialog box is 

displayed. Locate the file you wish to open and click Open. 
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The Gobe Productive Interface 
At the heart of Gobe Productive is a dynamic and powerful graphics-oriented 

user interface. The buttons, toolbars, and menus are simple, intuitive, and 

consistent. 

As you switch between different frames in a document, the interface dynami- 

cally changes to reflect the capabilities of the currently selected frame. For 

example, if you are working in a word processing document the toolbars at the 

top of the screen display tools specifically for the word processing environ- 

ment. If you switch to a graphics frame, the toolbars and menus change to 

display commands only applicable to the graphics environment. 

ar _ Edit i pet Frame “Window: = Format ~ Options ease See 

=SUM(A 1.45) 

if 
a Fa se si Bs ie es ie Bu. tnt. Tei Bo ae 

Hello, this i is a text fone 

StIAI Ry e|\|21O}0}d 

Wiseries 1 
Gseries 2 
Bseries 3 

=) moms 4 

Lt eles aan sey al aveere ak ie do me eel Eee a fen nets 

Figure 8 — This sample contains text (wod processing), spreadsheet and 

graphic frames, all within a single document. The spreadsheet frame is cur- 

rently active, thus the interface displays only those toolbars and menus appli- 

cable to the spreadsheet environment. Also, the Fill Tool has been “torn-off” 

and is displayed as a floating palette. 
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[icon [Environment/ Document Type ee ee 
Sin Seeere re 

| Image Processing 

Figure 9 - The Gobe Productive Environments. 

As seen in Figure 9, the Gobe Productive interface can be divided into six 
sections: Graphics, Word Processing, Spreadsheet, Table, Presentation, and 
Image Processing. 

An Intelligent and Simple Interface 
There are some common interface items in Gobe Productive that help you 
work smarter. In the middle of the Productive window is the workspace. 
This is where you type text, draw graphics, and do all your work. The 
environment icon in the left corner tells you which environment is currently 
active. The remaining interface items are consistent with the look and feel 
of BeOS. Scroll bars, resize tools, and the window tab all work the same as 
in any other BeOS application. 

| entitled : 2 
File cmt Frame Window Fort 
[rp] Groen ee Ee eS ee ie a) ABS Cle) oe) ey 
[o] ——— eae Set tbitat i satsis —+ oe . 

oe sere 
io] | Environment Icon 3 { Ruler | 

‘s Noes = 

[4] 
- ¥ « 
= i E Is Workspace 

i i 
— i 

Zoom Tool \ tke Bars J ' 

i Pana | i  / | L 
[es a M Bee 

Figure 10 — The Gobe Productive interface. 

Environment Icon: Indicates which type of environment is currently active. In 
the example above, the Word Processing environment is active. 
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Workspace: The workspace is the main working area. The Gobe Produc- 
tive suite is a What You See Is What You Get (WYSIWYG) environment. 
Items on the screen appear the same as in a printed document. The 
workspace also changes to reflect the currently active environment. Fora 
spreadsheet, the workspace contains rows and columns of cells, for graphics 
it contains a grid, and so forth. 

Scroll Bars: Use the scroll bars to move up and down or side to side in the 
workspace. The scroll bars are only displayed when the contents of the 
workspace do not fit within the window. 

Zoom Tool: Click the plus button (+) to zoom in, click the minus (-) button 
to zoom out. You can also tear-off the zoom tool to display a handy slider 
bar for controlling the zoom. Right-clicking on the + and - buttons incre- 
ments the zoom by 1% rather than the defined intervals. Also, single- 
clicking the zoom percentage reverts the zoom to 100%. 

Gobe Productive Bars 
There are four types of bars in Gobe Productive: the Menu Bar, the Format 
Bar, the Part Bar, and the Tool Bar. Bars display the Gobe Productive 
commands and can contain buttons, menus, or a combination of both. This 
section describes the basics of the different bars within Gobe Productive. 

The Menu Bar 

At the very top of the Gobe Productive document window is the MenuBar. 
The Menu Bar displays the appropriate menus for the currently active 
environment. Each document type has its own special menu items. How- 
ever, the first five menu items in the Menu Bar are common to all Gobe 
Productive documents. 

Common Menus 

File: Contains commands for opening, saving, and printing documents. 
This menu also accesses the application preferences and information areas of 
Gobe Productive. 

Edit: Contains commands (such as copying and pasting) for manipulating 
objects in Gobe Productive documents. 

Document: Contains menu commands that perform actions to the entire 
document. 

Frame: Contains commands for inserting and working with frames. 

Window: Contains commands and controls for the Gobe Productive win- 
dow. Contains commands for displaying or hiding interface items such as 
the Tool Bar, Part Bar, or Sheet Bar. 
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Graphics Environment Menu Bar 

Arrange: Contains commands that alter the layer qualities of frames and 

graphic items. This menu also contains commands to alter the rotation, 

scale, and layout of frames and graphics. 

Word Processing Environment Menu Bar 

Format: Contains commands for formatting text and inserting special 

document fields such as page numbers. 

Spreadsheet Environment Menu Bar 

Format: Contains commands for formatting cells including cell height and 

width. 

Options: Contains commands specific to a spreadsheet, such as sorting, 

filling, and calculating cells. 

Image Processing Environment Menu Bar 

Plugins: Contains the image retouching tools installed for your copy of 

Gobe Productive. Image retouching tools are categorized by the type of 
modifications they make to an image. 

Presentation Environment Menu Bar 

Arrange: Contains commands that alter the layer qualities of frames and 

graphic items. This menu also contains commands to alter the rotation, 

scale, and layout of frames and graphic items. 

Presentation: Contains commands specific to running a slide show presen- 

tation. 

The Format Bar 

The Format Bar is located right below the Menu Bar. It allows you to 

change the basic textual and graphical properties of a currently selected 

item. The Format Bar contains buttons that alter the color, fill, and text of 

various objects. From this toolbar you can also access stylesheets and 

name items in your document. 

Following is a description of the Format Bar buttons. All the buttons on 

the Format Bar can “tear away” to its own floating control palette. This 

option allows you to keep the tool open while you work. See page 31 for 

more information about the tear-off tools. 
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il a a a 
Dutch90] Rm BE The font tool sets the type of font to use for text. This 

S button has no effect on graphic items. 

The text size tool sets the size of the selected text. This 
button has no effect on graphic items. 

The text type tool sets the format for selected text (bold, 
underline, etc.). This button has no effect on graphic items. 

The text color tool (top image) sets the color for the 
selected text. When selected, the tool expands and displays 
a menu bar (lower image) for selecting the text color (solid, 
pattern, or gradient). The default text color for new text is 
black. This button has no effect on graphic items. 

The fill tool (top image) sets the color and transparency for 
filling a graphic or spreadsheet cell. When selected, the 
tool displays a popup menu bar (lower image) for selecting 
the color (solid, pattern, or gradient) as well as the 
transparency. The default fill color for new items is white. 
This button has no effect on text. 

The pen tool (top image) sets the color, pattern, weight, and 
style of the lines in a graphic. When selected, the tool 
displays a popup menu bar (lower image) for selecting the 
color (solid, pattern, or gradient) as well as the 
transparency, line size, and line style. The default pen 
color for new items is black. This button has no effect on 
text or spreadsheet cells. 

The style tool applies a style to a selected item. You can 
create styles that define properties for a graphic item, cells 
in a spreadsheet, or text. The tool displays the style 
applicable for any selected item or text. 

The name selection tool allows you to set or select named 
items. You can select any graphic, group of cells, or text, 
and give the selection aname. Using this button, you can 
select a named selection, edit the name, or create a new 
named selection. 
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The Shape Transparency tool sets the opacity or 
transparency of a selected frame or drawing object. When 

selected, the tool displays a popup box from which you can 
select a transparency percentage. 100% represents full 

opacity, 0% denotes total transparency. The shape 
transparency box can be torn-off to display a slider bar 

(lower image), which you can also use to choose the 

transparency of the selected object or frame. For more 

information about transparency, see the Transparency topic 

in the graphic section. 

The Part Bar 

The Part Bar is the most dynamic element of the Gobe Productive suite. 

Located between the Format Bar and the Workspace, the Part Bar changes 

to display the applicable tools for the current environment. 

Graphics Part Bar 

@ SeJeIe} ABIEIES 
f— 338in «=f 188in = =—le62in 4 450i jel sesn FT peen OQ OF 

os te eee ee 
Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that one or 
more graphic items are selected or that you are working ina 

graphics document. The graphics Part Bar is displayed when a 

frame is selected. 

Alignment Buttons: These buttons are enabled when more than 

one item is selected. Use the buttons to align multiple objects. 
The button icons represent each type of alignment available. 

You can align the objects to the top, bottom, right, and left, as 

well as distribute the objects horizontally or vertically. You can 

also align the centers of the objects vertically or horizontally. 

Text Wrap: This button controls how text wraps around a frame 
or drawing object. When selected, a Text Wrap dialog box is 

displayed. 

Arrow Head Style: Use this button (left image) to select arrow 
head styles for the Arc, Line, Freehand, Bezigon or Polygon 

Tools. Click on the Arrow Head Style button to display a popup 
menu (right image) from which you can select an arrow head 

style. 
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Description 

Left Position: This tool indicates the position of an item relative 
to the left side of the page. Click the number to activate the 

field. Once active you can manually enter a new left position 
value. You can change the units of measurement (inches shown) 

using the Preferences options from the File menu. 

Top Position: This tool indicates the position of an item relative 
to the top of the page. Click the number to activate the field. 

Once active you can manually enter anew top position value. 

You can change the units of measurement (inches shown) using 

the Preferences options from the File menu. 

Right Position: This tool indicates the position of an item 
relative to the right side of the page. Click the number to 

activate the field. Once active you can manually enter a new 
right position value. You can change the units of measurement 

(inches shown) using the Preferences options from the File 

menu. 

Bottom Position: This tool indicates the position of an item 

relative to the bottom of the page. Click the number to activate 
the field. Once active you can manually enter a new bottom 

position value. You can change the units of measurement 
(inches shown) using the Preferences options from the File 

menu. 

t 283in 

kee] 3.44 in 

+ 156 in 

Width: This tool indicates the width of a graphic item. Click 
the number to activate the field. Once active you can manually 

enter a new width value. You can change the units of 

measurement (inches shown) using the Preferences options from 

the File menu. 

Height: This tool indicates the height ofa graphic item. Click 

the number to activate the field. Once active you can manually 
enter a new height value. You can change the units of 

measurement (inches shown) using the Preferences options from 
the File menu. 

Rotation: This tool indicates the rotation angle of a graphic 

item. Click the number to activate the field. Once active you 
can manually enter a new rotation angle. 
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Word Processing Part Bar 

een _| Deserpion 
Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that a word 
processing frame is active or that you are working in a word 

processing document. 

Ela ele Alignment Buttons: These buttons control the alignment of the 
text (left, center, right, justified). 

i Line Spacing: These increment/decrement buttons increase and 

decrease the spacing between lines of text. Click the increase 
button (right) to increase the line spacing one-half line at a time. 

Click the decrease button (left) to decrease the line spacing one- 

half line at a time. 

Show/Hide Invisibles: Toggles the display of non-printing 
characters such as tab, paragraph, and space marks. 

Spell Check Button: This button starts the spell checker, and 
displays the SpellBar. The SpellBar is a special addition to the 

PartBar exclusively used for spell checking. 

Columns: These buttons add (right button) or remove (left 

button) columns in the document. 
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Spreadsheet Part Bar 
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Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that a 
spreadsheet frame is active or that you are working in a 

spreadsheet document. 

as Selected Cells: Displays the cells currently selected. Ifa named 
selection is selected, the name is displayed here. 

Alignment Tools: These tools control the horizontal and vertical 

text/number alignment of the selected cells. The left button is 
horizontal, the right vertical. When selected, a popup menu 

arson the different alignment choices. 

of cell borders. Simply select a range of cells and use the buttons 

to create, remove, and color the borders. When selected, a popup 
menu bar displays (lower image). Use the popup menu bar to 

select the color or the transparency of the border. 

eer 

Number Format: This button displays the Number Format 
dialog box. Using this dialog box you can set the number format 

for the selected cells. 

Create Chart: Places a new chart into the spreadsheet. 

Confirm and Cancel: Use these buttons to confirm or cancel 
the entry of values into a cell. These buttons are active only 

when you are using the Entry field to modify the contents of a 
cell. 

Functions: This button displays the Paste Function dialog box. 

Use this dialog box to select and paste one of the numerous 
functions provided. 

Entry Field: This field is used to directly modify or enter text, 

numbers, or formulas into a cell. 
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Chart Part Bar 

Oo 

| Right-click in the legend's colored boxes for options 

Icon __| Description 
Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that a 
charting frame is active. 

Alignment Buttons: These buttons are enabled when more than 

one item is selected. Use the buttons to align multiple objects. 
The button icons represent each type of alignment available. 

You can align the objects to the top, bottom, right, and left, as 

well as distribute the objects horizontally or vertically. You can 

also align the centers of the objects vertically or horizontally. 

WIEN 

Presentation Part Bar 
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The presentation environment uses the same bar as the graphics environ- 

ment. See page 19 for more information. 

Image Processing Part Bar 

oe een 
Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that an image 
processing frame is active or that you are working in an image 

processing document. 

Color Picker: This button allows you to select the foreground and 

background colors for image retouching. In this image the 

foreground color is black, and the background color is white. 
These colors are the default for the Color Picker. To select a 

different color, right click on the button to display the color palette. 
To create a new color, left click on the Color Picker. This displays 

a New Color dialog box where you can use sliders to select the 
Hue, Lightness and Saturation of the new color. Click on the arrow 

to switch the foreground and background colors. 
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Marquee Tool: The Marquee Tool is used to select a certain area 
of an image. When the cursor changes to display a crosshair, draw 

out the area of the image you want to select. Once selected, any 
command such as copy, delete, etc. applies to the selected area and 

not the entire image. To create multiple, non-congruous selections, 
click and hold [SHIFT] while you draw out each selection. 

Lasso Tool: This tool allows you to make a freeform selection of 

an image. 

Magic Wand Tool: This tool selects areas of an image by 
similarities in color and hue. Click on an area in an image using 

this tool and all congruous sections with alike color are selected. 

Magnify Tool: This tool increases the magnification level of the 
image. To zoom in, click the image with the primary mouse 

button. This increases the magnification factor by one level. 

Find Color Tool: Use this tool to select all areas in an image that 

contain the foreground color (as displayed in the Color Picker). To 
deselect the area, click on the tool again. 

Pencil: Use the pencil to draw freehand over the image. The 

pencil uses the foreground color displayed in Color Picker. To 
mask your drawing area, use the Marquee Tool to select an area 

first. 

Eraser Tool: Use this tool to erase parts or the whole image. The 
erased portion will have the background color you selected. 

Eye Dropper Tool: Use the Eye Dropper Tool to pick up an 

active color from the image. This tool allows you to get an exact 
match from a color in an image. 

Bucket Tool: Use this tool to fill an area with the foreground color. 

Place the black lip of the bucket on the area you want filled and 
click the mouse. The current foreground color is filled into all 

areas with congruous colors. To mask the fill area, use the 
Marquee Tool to select an area first. 

Air Brush Took: This tool simulates painting with an airbrush or 

spray can. When you click the tool, a dialog box is displayed 
where you can configure the type of brush, opacity, etc. To mask 

the airbrush area, use the Marquee Tool to select an area first. 

24 @ Section Ill - User Interface Overview 



Table Part Bar 

5 BES 

hea ee 
HA Environment Icon: Indicates the type of environment or 

document that is currently active. This icon indicates that table 

frame is active. 

BEE Alignment Buttons: These buttons control the alignment of text 
(left, center, right, justified). 

E — =u |= Line Spacing: The side buttons increase and decrease the 
spacing between lines. Click the middle button to display 

detailed options. 

Check Spelling: This button starts the spell checker, and 
displays the Spell Bar. The Spell Bar is a special addition to the 

Part Bar exclusively used for spell checking. For more 

information, please see the S pell Checking topic in the Gobe 

Productive On-Line help. 

Show/Hide Invisibles: Toggles the display of non-printing 
characters such as tab, paragraph, and space marks. 

Vertical Alignment: This tool controls the vertical text/number 
alignment of the selected cells. When selected, a popup menu 

displays the different alignment choices: Align Top, Align 
Center, Align Bottom. 

Insert Column: This tool inserts a column ina table. The new 

column is inserted to the left of the currently selected column. 

This feature is also available from the Insert Column menu item 

onthe Table menu. 

Insert Row: This tool inserts a row ina table. The new row is 

inserted above the currently selected row. This feature is also 

available from the Insert Row menu item on the Table menu. 

Merge Cells: This tool merges one or more cells into a single, 
larger cell. You can select cells from a row, from a column, or 

from both. This feature is also available from the Merge Cells 

menu item on the Table menu. 

Split Cells: Use this tool to split a cell into one or more child 

cells. You can select one or more multiple cells from rows or 
columns or both to split. This feature is also available from the 

Split Cells menu item on the Table menu. 
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The Tool Bar 

The Tool Bar is primarily for drawing and formatting graphic shapes. The 

Tool Bar is usually visible. If it is not visible, select View ToolBar from 

the Window menu. 

The Tool Bar contains the following tools. 

Selection Tool 

Use this tool to change the selection mode of the document. Click on the 

bottom right corner of the button to display a popup menu with these three 

selection tool options: 

Normal Use the normal selection pointer to select, move, and 

activate items in the workspace. 

Rotate When positioned at the corners of a selected frame or 
<, graphic item, the rotation pointer allows you to freely 

rotate an item or frame. This pointer works like a 
normal pointer when not positioned at the corner of a 

frame or item. 

Reshape | When positioned over the handle of a graphic item, this 
& point allows you to freely reshape an item. This is 

especially useful for graphic items with many handles, 

suchas a curve or Beizer Curve. This pointer works 
like a normal pointer when not positioned at the handles 

of an item. 

Frame Tool 

Use this tool to “draw” a new frame in the current workspace. To draw a 

new frame click the tool and select the type of frame you want to create 

from the popup menu. The cursor changes to a cross hair (+). Proceed to 

“draw” the new frame in the workspace. 
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Graphic Tools 

Use these tools for drawing graphic shapes. 

HM Click once on the tool to draw a single graphic. When finished drawing the 

graphic item, the cursor returns to the selection tool. 

H Double-click the tool for continuous drawing of that type of item. The 

cursor does not return to a selection tool when finished drawing. To unlock 

the continuous drawing mode, click the tool once. 

me aan 
Square/Rectangle Tool 

Circle Tool 

Hel Rounded Rectangle Tool 

El 

Draws a square or rectangle. 

Draws a circle or oval. 

Draws a rectangle with rounded comers. 

Draws a line. 

Draws a free hand shape. Freehand Tool 

Polygon Tool 

Predefined Shape Tool Draws any number of pre-defined shapes. 

Frames and Graphic Items 
Graphics are a fundamental aspect of the Gobe Productive suite. Frames, 

like a spreadsheet or word processing frame, behave the same as graphic 

items. You can apply borders, fill colors, even rotate a frame in the same 

way you can manipulate a box, oval, or line. 

Draws a Beizer curve. 

Draws a polygon shape. 

Unlike graphic items, frames have content inside them. A frame is essen- 

tially a floating version of an environment. If you insert a word processing 

frame into a graphics document, the word processing functions are all fully 

available when the frame is active. This introduces the important concept of 

selecting and activating in the Gobe Productive suite. 
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Table Frames 
The Table frame is an easy way to create table layouts in all environments. This 
tool is especially useful for making tables in word processing documents. 

While the table frame does share some characteristics with the spreadsheet, 
it is not a true spreadsheet environment. Rather, it is a specialized frame 
that gives you the flexibility to layout text, images, or even other tables. 

A BES) 8 &e) 
Cid Eien Bei SI Se s 2aeaeree| 

The Table Frame 

Bi cocmeen eo oe _ 

Elisd 

Dear Ecstatic User, 

Thank you so much for your letter describing your wonderful experiences using Gobe 
Productive. 

Lorem ipsum dolor sit et amet, vupute minim consectetuer in erat de adipiscing elit, sed de 

[This isan | inline Table Frame 

diam nonummy nibheuismod et[¢@csasa_ [character inthe text | incidune wat 
laoreet dolore magna aliquam erat volutpat. 
Utwisi enim ad minim wesm, quis nostrud execi taton ullamcorper suscipit lobortis nisl ut 
aliquip ex. 

Dus [2 : : Floating Table Fram ae l 
autem The i | frame moves above the teat in its own layer. vel 
eum =) 

‘You speci! how the text ‘aps around the frame 
irure pect, | Se | en 
dolor | Here some cells have been merged for clearer writing 

hendrent vupute vel velit esse molestie conseqat sequat, vel illum dolore ven eu feugiat 
nulla facilisis at vero eros et accumsan naet iusto odio dignissim qui vel blandit praesent 

__luptatum zzril delenit augue duis do te feugait nulla facilisi. Ipsumdolor sit amet, _ 
Page 1 AIP] ree 

Figure 1] — Example of a Table Frame. 

Table frames can be both in-line or floating. You can also insert rows and 
columns as well as merge and split cells. 

For more information on Tables, please refer to our documentation. 
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Transparency 
Transparency allows you to set how background colors “bleed” into a fore- 

ground image. All graphic objects possess a transparency or opacity property. 

Transparency allows you to have colors, patterns, etc. from the background 

“show through” in an image or layered graphic. 

ods a ae 
Figure 12 — Fansparency Examples. 

In the first example, there is no transparency on the star, thus none of the 

background color shows through. In the second example, a partial transparency 

allows a little of the background to bleed into the star. In the last example, the 

star is fully transparent and thus the background shows through entirely. 

Transparency can be set two ways. You can use the Text Color, Fill, or Pen 

Figure 13 — Format Bar with Transparency tool highlighted. 

For more detailed information, see the Graphics section of the Gobe Productive 

On-Line help. 

Selecting and Activating 
Selection in the word processing and spreadsheet environment is the process of 

highlighting cells or text. To select text, you position the cursor in the text flow, 

hold down the mouse button, move the mouse, and highlight the text you want 

to select. Selecting cells in a spreadsheet works in the same way. 

However, when you are working with frames and graphic items (in any environ- 

ment), selection works slightly different than selecting text in a text flow or cells 

on a spreadsheet. When you select a frame or graphic item, small “handles” 

appear on the edges of the item. Since all frames behave like graphic items, 

when a frame is selected, it can be resized, rotated, etc. 

If you want to work on the content inside a frame, though, it must be activated. 

To activate a frame, you must double-click anywhere in the frame. The Gobe 

Productive interface then changes to display the tools and menus applicable for 

the activated frame. For example, while working in a word processing docu- 

ment, if you insert a spreadsheet frame, the interface changes to display tools and 

menus applicable for the spreadsheet environment. 
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Sheets 
In addition to having many different frames within a document, the Gobe 
Productive suite also allows multiple sheets within a single document file. 
Sheets are basically “sub-documents”. For example, you can create a single 
Gobe Productive file with a word processing sheet, a spreadsheet sheet, a 

presentation sheet, and an image processing sheet. You could contain all 

your important documents for a particular report, project, or presentation 
ale one OCR ns file. 

rs a - tel x 9 

Figure 14— Example of sheets within a document. 

For example, the document in Figure 14 has four sheets: Report, Supporting 
Data, Graphics and Slide Presentation. Each sheet is essentially a whole 

new document, yet contained within a single document file. 

The Sheet Bar that displays the different sheets within a document is by 

default hidden. So you must select “Show Sheet Bar” from the Window 

menu to display this toolbar. To add, delete or rename sheets, select the 

Sheet Tool on the left of the Sheet Bar (open in the example). 

Footnotes/Endnotes 

30 @ Section 

Footnotes and Endnotes allow you to comment on text with call-out text at 

the bottom of a page or end of a document. 

Footnotes appear at the end of each page in a document. Endnotes appear 
at the end of a document. You can have both footnotes and endnotes in the 
same document. For example, you can use footnotes for detailed comments 
and then use endnotes for the citation of sources. 

@ Footnote at End of Page 

( Endnote at End of Document 

=... 
‘<= —| 

Options... | Cancel a 

Figure = Foner dialog box. 

| 
| 
| 
1 

A footnote or endnote consists of two linked parts: the note reference mark 
and the corresponding note text. Gobe Productive can automatically 

number the note reference marks, or you can create your own custom 

marks. If you add, delete, or move a footnote or endnote, Gobe Productive 

automatically renumbers them. You can format note text in any way, 

including adding graphics. 
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Tear-Off Tools 
Tear-off tool palettes are an alternative way to use some of the tools in the 

Gobe Productive suite. Many tools on the Format Bar and Part Bar can be 

“torn-off” to create a floating palette that displays all the commands and 

features available for the tool. This is useful if you use a particular tool 

frequently. 

lo 

1. 

Tear-Off a Floating Tool Palette 
Use your mouse and position the cursor over a tool. This example is 

tearing off the Fill tool. 

Arrange 

Click and hold on the tool. The popup menu for the tool appears. 

Drag the cursor into the workspace or until the outlined box appears. 

Keep holding the mouse button down. 

OSSBG000088a 
OB8OG0000080 
Og@o00000000 

Position the outlined box where you want the floating palette to appear. 

@ @s 

i E 125in 

Release the mouse button to “drop” the palette. The palette appears. 

You can always move the palette again. Simply “grab” the window tab and 

move it wherever you want. 

To close a palette, click the close button in the window tab. 
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AVE For Nore Help 

We hope you have enjoyed this Getting Started Guide. For additional help using 

the specific components of Gobe Productive, please refer to the following 

resources. 

Gobe Productive On-Line Help 
The Gobe Productive On-Line Help provides detailed instructions for using 

Gobe Productive. There are three ways to access the on-line help. 

From the Gobe Productive Suite 

1. Open Gobe Productive. 

2. Click on the File menu. 

3. Select Help. 

From the Gobe Directory 

1. Open the directory where you installed Gobe Productive. 

2. Open the Help directory. 

3. Double-click on Index.html. 

From the Gobe Software Website 

1. Go to: http://www.gobe.com/support/helpGP2-0/index.html. 

Technical Support 
Gobe Productive technical and software support is available on the web at 

http://www.gobe.com. It is also available via e-mail at support@gobe.com. 

New features and updates are always being developed. For the latest updates 

and plug-ins drop by the Gobe Software website at 

http://www.gobe.com. 
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Gen 

New Document 

Open File 

Close 

Save 

Save As 

Print 

Help 

Quit/E xit 

Undo 

Redo 

Cut 

Copy 
Paste 

Copy Format 

Paste Format 

Select All 

Duplicate 

Spell Check 

Show Spell Bar 

Find/Replace 

Find Again 

Find Selection 

lace/Find Again 

Cycle Windows 

Show ToolBar 

Image Processing 

Deselect SHIFT+ALT+A 

Unfloat Selection SHIFT+ALT+F 

eral 

ALT+N 

ALT+O 

ALT+W 

ALT+S 

SHIFT+ALT+S 

ALT+P 

ALT+? 

ALT+Q 

ALT+Z 

SHIFT+ALT+Z 

ALT+X 

ALT+C 

ALT+V 

SHIFT+ALT+C 

SHIFT+ALT+V 

ALT+A 

ALT+D 

ALT+= 

SHIFT+ALT+= 

ALT+F 

ALT+G 

SHIFT+ALT+F 

SHIFT+ALT+G 

ALT+, 

SHIFT+ALT+T 

Invert Selection ALT+I 

Previous Plug-In SHIFT+ALT+P 

Keyboard Shortcuts 

ap noes 
Bring to Front 

Send to Back 

Move Forwards 

Move Backwards 

Align to Grid 

Rotate 

Reshape 

Group 

Ungroup 

Lock 

Unlock 

AutoGrid 

SHIFT+ALT+ > 

SHIFT+ALT+ © 

ALT+ > 

ALT+ © 

ALT+K 
ALT+R 
SHIFT+ALT+R 
ALT+J 

SHIFT+ALT+J 
ALT+L 

SHIFT+ALT+L 
ALT+Y 

Spreadsheet 
Lock Cells 

Unlock Cells 

Fill Down 

Fill Right 

Insert Cells 

Delete Cells 

Sort Cells 

Calculate Now 

ALT+L 

SHIFT+ALT+L 

ALT+D 

ALT+R 

SHIFT+ALT +I 

SHIFT+ALT+K 

ALT+J 

ALT+E 

lable 
Select Row OPT+ALT+R 

Select Column OPT+ALT+C 

Word Processing 
Insert Frame Break ALT+ENTER 

Insert Page Break SHIFT+ALT+ ENTER 

Show Invisibles ATL+; 
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Quick Reference 

Formatand Sheet Bars 

ch@O1RMBT : 

Add/Delete Sheet a) Text Type Tool (=) Text Color Tool 

‘Sheet 1 | Sheet Tab |] Font Size J—sFill Tool 

chsol Font Tool Name Selection eal | Pen Tool 

Style Tool Shape 
Transparency 

Gerace palieigeribeortrster Beant 

ee oe 

ay Part Indicator t Bottom Position Align Graphics Top/Bottom 

f- Left Position |e{ Width Align Graphics Left/Right 

tT Top Position = Height Center Align 

—| Right Position = Rotation Angle Distribute Graphics 

Text Wrap =] Arrows 

Word Processing Part Bar 

cae 
Part Indicator Right Position Remove Column 

Left Position Full Justified [23] Add Column 

Top Position [=| 1501 [=] Line Spacing iia Spell Checking 

Show Invisibles 
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Quick Reference 

Spreadsheet Part Bar 

3 [es [#] 
(EJ-) Entry Bar 

a Part Indicator Ed a Alignment Tool 

oe Selected Cells [4] Number Format 

Border Tools (iu) Create Chart Button 

Table Part Bar 

BREESE EE) HEP eae 

Confirm Button 

Cancel Button 

Function Button 

AB 
EEE Part Indicator Spell Checking Insert Column 

BEES Text Alignment Show Invisibles Insert Row 

re Line Spacing Vertical Alignment Merge Cells 
La] . 
ss Split Cells 

Color Selection, 

Color Selection Pattern Selection Gradient Selection 

one) (QJ eer ~ ieee _ [s Fill Tool 
an 
| te a) Pen Tool 
DB fica I 

| BEES Text Color Tool Loe 
OBUaon | (¢] 
GSoSo | f=] Color Tool 

(2| Pattern Tool 

(| Gradient Tool 


